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Section 1 Introduction 

The IWR Tide Tool allows for the review of existing reference, secondary, and current stations 
as well as the creation of custom tide stations.  The tool provides access to information on 
astronomical tides at tidal stations around the world. This tool utilizes the tide prediction 
engine WTides developed by Philip Thornton (http://www.mdr.co.nz/) to estimate 
astronomical tide height and current levels.  These are the same values commonly published in 
tide tables, but are not the meteorological tide values that may be influenced by storms.  

Section 1.1 Tide Theory 
The basic method used for long-term prediction of astronomical tides (i.e. tide independent of 
local weather and riverine flow).  Harmonic analysis was developed starting in 1867, and relies 
upon summing a number of harmonic (cyclical) constituents to arrive at a tide prediction for a 
given location and time.  Each constituent represents a particular cosine curve, and the sum of 
these curves is a time function of the tide. Some 37 constituents are recognized and published 
for various locations as “harmonic constants”, i.e. the data defining the cosine curves.  Each 
such curve is of the form: 

Tidal Height Contribution = A*B*cos(Ct + P) 

where, A, B, C, and P are all constants for the location and constituent, and t is time.  

Here, C represents an astronomical frequency that is constant on the scale of centuries, referred 
to as “speed”.  A is the local port amplitude, and B is an annual correction called the node 
factor.  The phase lag (P) is the sum of the phase at Greenwich at the beginning of the year and 
the local port phase lag.  Total tide height at a given location is obtained by summing the tidal 
height contribution for each of the constituents. 

http://www.wes.army.mil/el/dots/drptnote/drp1-19.pdf gives a more detailed description of 
the harmonic analysis algorithm, noting that: 

“...the tide is represented as the sum of a coefficient multiplied by the cosine of its respective arguments. A 
finite number of constituents are used in the reconstruction of a tidal signal. The values for the 
arguments are generally computed through least squares analysis of prototype data. The National 
Oceanic and Atmospheric Administration’s National Ocean Survey generally uses 37 constituents in its 
published harmonic analyses. These results are usually based on an analysis of a minimum of 1 year of 
prototype data. ... The astronomical constituents ... are associated with a subscript that indicates the 
approximate number of cycles per solar day (24 hr). The constituents with subscripts of 2 are classified as 
semidiurnal-constituents and produce a tidal contribution that occurs approximately twice a day. 
Diurnal constituents occur approximately once a day and have a subscript of 1.” 
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Further discussion of the calculation algorithm and meaning of the various factors is contained 
in the documentation for XTide, a well-known implementation of harmonic analysis: 
http://www.mlb.co.jp/linux/science/xtide/doc/verbose_docs.txt. 

Section 1.2 Tide Tool Overview 
The IWR Tide Tool allows the user to drill into specific geographic regions and select an 
existing tide or current station for review. Once a station is selected, the user is provided with a 
graphical display of the location of the currently selected station on a map as well as other 
textual type information pertaining to the selected station. Users can obtain general information 
such as the name, type, latitude, longitude and the harmonics source file of the selected station 
as well as more detailed information such as the time and value of the tide in fifteen minute 
increments for a user defined time frame. The information available in the tool can be exported 
to CSV or Excel format for analysis and use outside the IWR Tide Tool through the export 
function available under the Data pillar. 

In addition to reviewing existing tide and current data, this tool allows for the creation of 
custom stations based on reference stations. In order to create these custom stations, the user 
will need to input some necessary parameters such as the reference station in which this 
stations will be based upon, latitude, longitude, name, and the minimum and maximum time 
add that should be used for this custom station. Once created, these custom tide stations can be 
made available in other tools such as HarborSym.  
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Section 2 Installation 
The IWR Tide Tool software is primarily distributed by Internet download, although it can also 

be distributed by CD-ROM, upon request. 

Installation procedures vary slightly depending on the Windows Operating System. Windows 

XP users must follow steps to have Powershell installed, if not already installed. Variations in 

install instructions are provided as they arise. 

2.1 System Requirements 
Before installing the Tide Tool, make sure the computer system meets the following hardware 

and software requirements: 

 Windows XP with SP 3 or Windows 7 

 Minimum RAM of 4GB 

 Administrator permission on the computer for installation purposes 

 Wtides  

o If HarborSym is installed on the machine, WTides should already be there as it is 

part of the HarborSym installation.  If the IWR Tide Tool setup cannot find WTides 

on the machine then WTides will automatically be installed during the installation of 

the IWR Tide Tool. 

 SQL Server Express 2008 R2, installation files provided 

 Microsoft .NET Framework 3.5 and Microsoft Windows Installer 4.5, installation files 

provided 

 

2.2 Installation Procedures 

2.2.1 CD-ROM Installation 

Insert the Tide Tool CD-ROM into your CD-ROM drive. 

Wait for the setup program to start. 
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Follow the instructions to complete setup; it is recommended for users to accept all default 

settings. 

2.2.2 Internet Download Installation 

Please contact the Institute for Water Resources (IWR) to obtain a copy of the tool. 

Wait for the setup program to start. 

Follow the instructions to complete setup; it is recommended for users to accept all default 

settings. 

2.2.3 Installation Instructions 

The IWR Tide Tool requires that SQL Server Express 2008 be installed on the user’s machine.  

The SQL Server install that is included also will install the SQL Server Management Studio.  The 

SQL Server Management Studio must be installed so the primary user can be granted database 

privileges to allow them to attach/detach/modify the Tide Tool database.  If the primary user is 

not granted these privileges, the Tide Tool application will not function properly. 

SQL Server Express 2008 Installation Guide 

Starting the Install 

Start the SQL Server Express 2008 R2 installation by double-clicking the file 

‘SQLEXPRWT_x86_ENU.exe’ located in the directory SQL_Server_2008_R2.   If a Window’s 

security warning appears, select “Run” or “Yes”.  

Prerequisites 

There are two prerequisites for the install to run:  Microsoft .NET Framework 3.5 and Microsoft 

Windows Installer 4.5.  If either of these is not installed, a message box similar to Figure 1 will 

appear with the name of the missing component and corresponding link that can be clicked to 

acquire it.  If both prerequisites are already installed and the message box in Figure 1 does not 

appear, please skip ahead to the section entitled ‘Installation of SQL Server Express 2008 R2’. 
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.NET Framework 3.5 

Clicking on the links provided in the dialog in Figure 1 will begin the download and installation 

of each missing prerequisite.   Figure 2 shows a warning message for the .NET setup executable.  

Click the ‘Run’ button to continue.  

 

After the file has downloaded and extracted, the following dialog (shown in Figure 3) will be 

displayed.  Select the radio button stating that you have read the user agreement and accept its 

terms and click the ‘Install’ button. 

 

  Figure 1: Message Box Listing Missing Prerequisites 

Figure 2: Security Warning for Running the .NET 

Framework 
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This will result in the 3.5 Framework being installed.  Please be patient during this process as it 

can take a few minutes.  If the framework installs successfully you should see a ‘Setup 

Complete’ message like the one in Figure 4. It is recommended that you check for updates by 

clicking the highlighted link. 

 
Figure 4.  .NET Framework 3.5 setup completed. 

Figure 3.  .NET Framework 3.5 user agreement. 
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After any updates have finished installing, close the form in Figure 4 by clicking on the ‘Exit’ 

button. 

Windows Installer 4.5 

You will be prompted in Figure 5 whether you want to run Windows executable that will be 

responsible for downloading the Windows Installer 4.5 setup file.  Select ‘Run’.  

 

After the setup executable has downloaded a prompt will be shown asking if you want the 

Windows Installer 4.5 setup file to run.  Again select ‘Run’. 

 

This should launch the Windows Installer setup.  You should see a prompt like the one in 

Figure 7.  Go ahead and select the ‘Next’ button. 

Figure 6.  Prompt to run the installer. 

Figure 5. Security warning.
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When the Windows Installer user agreement is shown (Figure 8) select the ‘I Agree’ option and 

click ‘Next’. 

 

You might receive a notice such as the one displayed in Figure 9 that the Windows Installer 

services will be restarted.  Select ‘Continue’. 

Figure 8.  Windows Installer 4.5 user 

Figure 7.  Windows Installer 4.5 setup wizard. 
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When the installation has completed, you will be warned that in order for the changes to take 

effect that a restart of the computer is required.  Go ahead and select the ‘Finish’ button. 

 

Selecting the ‘Finish’ button will cause your computer to reboot.   If for some reason, your 

computer does not reboot automatically after several minutes, manually restart. 

After the computer has restarted, if the SQL Server install does not automatically restart, double 

click the file ‘SQLEXPRWT_x86_ENU.exe’ to manually restart it.  Again, select ‘Run’ if a 

Window’s security warning appears. 

Installation of SQL Server Express 2008 R2 

Starting the installer will launch the SQL Server Installation Center shown below in Figure 11.  

Select the option for ‘New installation or add features to an existing installation’. 

Figure 10.  Windows Installer setup complete. 

Figure 9.  Service restart 
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It is important to be patient during the SQL Server installation process.  Many of the steps can 

take several minutes or more to complete.  Often a wait message such as the one in Figure 12 

will be displayed. 

 

When the SQL Server license agreement appears, check the ‘I accept the license terms’ option 

and click the ‘Next’ button (Figure 13). 

Figure 12.  Installation wait message. 

Figure 11.  SQL Server Installation Center. 
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Please wait while the SQL Server installer sets up support files as this could take a few minutes.   

Installing Windows PowerShell 

Oftentimes when the Setup Support Rules screen finally appears, the rule ‘Windows 

PowerShell’ has failed (Figure 14).  If this happens it simply means that the Windows 

PowerShell has not been installed. It is typical to receive this notification for Windows XP users.  

If none of the support rules have failed (typical of Windows 7 users), please skip to the section 

entitled ‘SQL Server Feature Selection’. 

Figure 13.  SQL Server License Agreement 
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An executable has been included that will install Windows PowerShell 2.0 or one can be 

downloaded at http://support.microsoft.com/kb/968929.    The executable that has been 

provided is called WindowsXP-KB968930-x86-ENG.exe.  Double-click on this executable and 

after the Installation wizard appears (shown below in Figure 15),then click the ‘Next’ button. 

 
Figure 15.  PowerShell installation wizard. 

Figure 14.  Setup Support Rules show Windows PowerShell failed. 
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This will bring up the license agreement (Figure 16).   Check the ‘I Agree’ option and click the 

‘Next’ button to begin the installation. 

 

When the installation completes, click the ‘Finish’ button to close the window and rerun the 

setup rule check by clicking the ‘Re-run’ button located on the right side of the form beneath the 

progress bar (Figure 17). 

 

All rules should pass and a Feature Selection form like the one shown in Figure 18 should be 

displayed.   

SQL Server Feature Selection 

In the Feature Selection Form, all features are selected by default and there is a default 

installation directory.  If for some reason the default directory is not desirable, it is OK to select 

a different installation directory, but leave all Instance Features selected.  Select the ‘Next’ 

button to proceed. 

Figure 17.  Re‐run the rule check. 

Figure 16.  PowerShell License Agreement 
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Clicking the ‘Next’ button should bring up the Instance Configuration form shown below in 

Figure 19.  You should be able to accept the form’s default options.  However, make sure the 

‘Named instance’ option is checked and the instance name and the instance ID are the same.   

Click the ‘Next’ button. 

Figure 18.  Feature Selection 
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This should bring up the Server Configuration form.  Be sure that SQL Server Browser has the 

account name ‘NT AUTHORITY\LOCAL SERVICE’ selected and the SQL Server Database 

Engine has ‘NT AUTHORITY\SYSTEM’ selected (will not by selected by default).   

 

The Password field should be disabled.  Figure 20 shows how the form should look.  Click the 

‘Next’ button when ready to proceed.  

This should bring up the Database Engine configuration screen.  The default selection should be 

‘Windows authentication mode’.  Before continuing, click ‘Add’ to add grant all user’s SQL 

Server administrator privileges, as shown in Figure 21.  

Figure 20.  Server Configuration

Figure 19.  Instance Configuration 
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Figure 21.  Database Engine Configuration 

In the box provided, enter ‘users’ and then click ‘Check Names’, shown in Figure 22. Windows 

will populate the box with the proper name. When finished, click ‘OK’.  

 

Figure 22.  Add Users to SQL Administrators 
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The user will be returned to the Database Engine configuration screen. As shown in Figure 23, 

be sure that the newly added Users is in the list under Specify DQL Server administrators and 

then select Next.   

 

Figure 23.  Server Configuration 

Click the ‘Next’ button to bring up the Error Reporting screen.   

 

Nothing needs to be changed on the Error Reporting screen so just click the ‘Next’ button to 

begin the installation of the selected components.  The installation will take several minutes.  A 

notice should appear once the installation has completed.  Just click the close button to exit out 

of the installation wizard.  

Figure 22. Error Reporting 
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Figure 23.  Installation completed successfully. 

 

Resolving the “mscorlib.tlb” Error 

Sometimes during the SQL Server setup process, the file mscorlib.tlb cannot be located.  In this 

case, you will receive an error on startup of SQL Server Management Studio stating ‘The file 

C:\Windows\Microsoft.NET\Framework\version_number\mscorlib.tlb could not be loaded. 

An attempt to repair this condition failed because the file could not be found. Please reinstall 

this program.’   

If this happens click the ‘OK’ button on the error message and exit out of the Management 

Studio.  This issue is documented by Microsoft (http://support.microsoft.com/kb/918685 ), 

and you can follow their steps for solving the issue for SQL Server 2008.  For convenience, the 

instructions are also included below. 

For SQL Server 2008 

To work around this problem, you must manually specify the correct path of the Mscorlib.tlb 

file in the registry. To do this, follow these steps:  

1. Click Start, click Run, type regedit, and then click OK. 

2. Locate the following registry subkey:  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 

Server\100\Tools\Shell\TlbAutoRepair\mscorlib.tlb Notes 
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If you install the 32-bit version of SQL Server 2008 on 64-bit operating systems, locate the 

following registry subkey:  

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Microsoft SQL 

Server\100\Tools\Shell\TlbAutoRepair\mscorlib.tlb 

If you install SQL Server 2008 Express Edition with Advanced Services, locate the following 

registry subkey:  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Microsoft SQL 

Server\100\Tools\ShellSEM\TlbAutoRepair\mscorlib.tlb 

3. In the right pane, double-click TlbPath.  

4. In the Value data box, replace %CLRVERSION% with the following value:  

v2.0.50727  

Note: The value v2.0.50727 indicates the version of the .NET Framework that the 

original release version of SQL Server 2008 uses.  

5. Click OK, and then exit Registry Editor.  

Important If you install a SQL Server 2008 service pack or hotfix, the service pack or hotfix will 

change the value that you replace in step 4 back to %CLRVERSION%. If the problem that is 

described in this article still exists after you install the service pack or the hotfix, you must 

following these steps again to work around this problem. 

Installing IWR Tide Tool 

Double-click on the setup.exe file to begin the Tide Tool installation.  If asked, please accept the 

Microsoft Software Supplemental License Terms. The Google Earth plug-in is required by the 

Tide Tool in order to view to tide station globe.  If you have the Google Earth plug-in installed 

on your machine, please skip to the section titled ‘IWR Tide Tool Setup’.   If the plug-in is not 

already installed on the machine, the message box shown in Figure 24 will be displayed. 
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Figure 25.  Google Earth Plug‐in Download Page 

 

Please click the ‘Yes’ button.  This will open an internet browser window to the Google Earth 

website where the plug-in can be downloaded, as shown in Figure 25. 

Click the ‘Download Google Earth Plug-in’ button on the web page.  When the file download 

security warning appears, select ‘Run’, as shown in Figure 26. 

Figure 26.  File Download Security Warning 

Figure 24.  Google Earth Plug‐in Prompt 
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Figure 28.  Google Earth Plug‐in Installation Complete 

After the setup file is downloaded to a temporary directory, you will receive another security 

warning, as shown in Figure 27.  Select ‘Run’ again. 

Please wait while the Google Earth plug-in downloads and installs on the machine.  This could 

take several minutes depending on the internet connection.  When the plug-in has finished 

installing, you will receive the message box displayed in Figure 28.  Click on the ‘Close’ button 

to exit the install. 

Because the Google Earth plug-in install is separate from the Tide Tool install, the Tide Tool 

installer must be restarted.  Click on the setup.exe to restart the Tide Tool installer. 

 

Figure 27.  Security Warning 
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IWR Tide Tool Setup 

Once the installer begins, the IWR Tide Tool Setup screen will appear.  Click the ‘Next’ button 

to proceed, as shown in Figure 29. 

 

This will bring up a form where the desired installation directory can be specified (Figure 30). A 

default directory is given but can be changed by clicking the ‘Browse’ button.  Also note the 

application should be installed with the ‘Everyone’ option selected. 

Hit the ‘Next’ button once you have chosen the desired setup options, and click the ‘Next’ 

button on the following screen to begin the installation process.  This will take several minutes. 

Figure 29.  IWR Tide Tool Setup Wizard

Figure 30. Tide Tool Setup Options 
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Figure 33. WTides Setup Complete 

Figure 32.  Prompt for WTides data directory 

One of the last steps during the Tide Tool install is to either install a fresh copy of WTides or 

locate an existing installation.  When this step is reached a notification like the one in Figure 31 

will be displayed.   

The Tide Tool install will first search the main program files directory for a WTides installation.  

If no installation can be found, you will be asked if there is a WTides installation in a different 

location on the computer (Figure 32).   

If a WTides installation does exist, and you click ‘Yes’ to the dialogue you will be prompted to 

browse to the WTides location.  If WTides is not present on the machine, you will be asked to 

choose a location for a new install of WTides.  Once this process has completed, a ‘Setup 

Complete’ message will be displayed (Figure 33). 

Once the Tide Tool has completed its installation, click the ‘Close button (Figure 34).   

Figure 31. WTides Installation 
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Running the Tide Tool for the First Time 

When the Tide Tool is started for the first time after installation, there is no database assigned to 

it.  The application contains a new template database that can be used if the user does not 

already have one.  The application will prompt the user if they want to use this template 

(default) database.  In most cases, the response will be ‘Yes’ (Figure 35). 

 

Figure 35.Confirm Tide Tool Database 

Once the application knows what database to use, the Explorer screen will open.  If the default 

database was selected for use, the application will have to populate it with the tide stations 

from the WTides engine. The warning shown in Figure 36 will alarm the user that the database 

is empty and that they should wait while it is populated with station data. Simply select ‘OK’. 

Figure 34.  Tide Tool Installation Complete 
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Figure 36.  Database Population Message 

 

2.2.4 Uninstall 

Click the Start button on the Taskbar. 

Click Settings. 

Click the Control Panel. 

Double-click Add/Remove Programs. 

Select “IWR Tide Tool”. 

Click the Add/Remove button. 
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Section 3 Overview 

3.1 Title Bar 
The Title Bar, shown in Figure 37, is located at the top of the tool. It lists the name of the 

application on the left side. The right part of the Title Bar provides users with the standard 

Microsoft Windows controls for: minimizing the Tide Tool application, maximizing the Tide 

Tool application and closing the Tide Tool application.  

 

Figure 37.  Title Bar 

3.2 Menu Bar 
The Menu Bar is found directly below the Title Bar. The Menu Bar provides users with access to 

the application’s dropdown menus containing many useful commands, as shown in Figure 38. 

  

Figure 38.  Menu Bar 

3.2.1 File 

Clicking on the File menu option, drops down the menu shown in Figure 39. Three commands 

are available from the File menu: Database Setup, Reload WTides Stations into Database, and 

Exit.  

 
Figure 39.  File Menu Options 

Database Setup Clicking on the Database Setup selection will open the Database Manager form 

shown in Figure 40. This form can be used to change the local SQL Server Instance if more than 

one exists. It also allows the user to detach an existing database or to attach a new database by 

selecting the MDF and LDF files and entering a name for the database. 
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Figure 40.  Database Manager 

Reload WTides Stations into Database Selecting this menu option will delete all existing 

WTides stations from the tool and reload them from the WTides data files. This process takes 

some time so when the menu option is selected the user receives a message to verify they would 

like to continue. 

Exit Clicking on the Exit command will close the IWR Tide Tool application. 

3.2.2 Data 

Six commands are available from the Data menu option: Generate Station List, Export to CSV, 

Export to Excel, Output Metonic Tide Statistics, Output Station Statistics for Period, and Output 

Full Station Report for Period. Different options on this menu will be enabled based on where 

the user is at in the navigation pane. After initially launching the application, the Generate 

Station List option will be the only option enabled. However, once a tide station is selected 

using the Navigation Pane, the remaining menu items will be enabled.  

3.2.1.1 Generate Station List 

 Selecting Generate Station List from the Data menu will create a text file that contains a list of 

all station names, the name of the harmonics file (in WTides) where the station information is 

located, and their latitude and longitude. When the user selects this menu option, they will be 

prompted to enter a file name (Figure 41). After entering a file name and clicking Save, the text 

file will be created.  
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Figure 41. Save Station List 

After the text file is created, the user receives a message stating that the file has been created 

and its location on the machine. The user should then click OK to continue using the tool. A file 

similar to the one shown in Figure 42 will now be available at the user specified location. 
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Figure 42.  Station List Report 

3.2.1.2 Export to CSV  

As shown in Figure 43, selecting the Export to CSV command from the Data menu provides the 

user with two options, to export the Exceedance Function or the Tide/Current Values to CSV 

(Comma Separated Value) format. Note that tide values are exported in feet and current data 

are exported in knots. 

 

Figure 43. Data Export to CSV 

Exceedance Function   Selecting Exceedance Function will export the tide value or current value 

(in knots) and Exceedance Function data for the currently selected station to a CSV file 

(depending on whether a current or tide station is selected). The user will be prompted to enter 

a name for the CSV file. After entering the name and clicking Save, the file will be created. 
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After the file is created, a message identifying the number of rows exported is displayed to the 

user as well as an option to open the file for viewing. To open the file, the user should click Yes. 

If the user does noit wish to view the file at this time and would like to continue using the 

application, click No. 

Tide/Current Values    Selecting Tide/Current Values will export the Time and Tide Value or 

Current Value data for the currently selected dock and specified time frame to a CSV file 

(depending on whether a current or tide station is selected). The user will be prompted to enter 

a name for the CSV file. After entering the name and clicking Save, the file will be created. 

After the file is created, a message identifying the number of rows exported is displayed to the 

user as well as an option to open the file for viewing. To open the file, the user should click Yes. 

If the user doesn’t wish to view the file at this time and would like to continue using the 

application, click No. 

3.2.1.3 Export to Excel   

This menu option will enable the user to export to Excel format the Exceedance Function, the 

Tide/Current Values, or Both, as shown in Figure 44. The ability to export to Excel will be 

disabled if minimum RAM requirements are not present on the machine or the data range to be 

exported exceeds the Excel limit. If the export is disabled, the CSV option can be utilized. Note 

that tide values are exported in feet and current data are exported in knots. 

   

Figure 44. Export to Excel 

Exceedance Function   If Exceedance Function is selected, the user will be prompted to enter a 

file name. After entering the file name the user should click Save to create the Excel File with the 

values and exceedance functions for the selected tide or current station.  

After the file is created, a message is displayed to the user providing an option to open the file 

for viewing. To open the file, the user should click Yes. If the user doesn’t wish to view the file 

at this time and would like to continue using the application, click No. 



31 

Tide Height Grid   If Tide Height Grid is selected, the user will be prompted to enter a file name. 

After entering the file name the user should click Save to create the Excel File with the time and 

value information for the selected tide station. 

After the file is created, a message is displayed to the user providing an option to open the file 

for viewing. To open the file, the user should click Yes. If the user doesn’t wish to view the file 

at this time and would like to continue using the application, click No. 

Both   If Both is selected, the user will be prompted to enter a file name. After entering the file 

name the user should click Save to create the Excel file. The resulting file will have one 

worksheet containing both the Exceedance Function information and the tide/current value. 

After the file is created, a message is displayed to the user providing an option to open the file 

for viewing. To open the file, the user should click Yes. If the user doesn’t wish to view the file 

at this time and would like to continue using the application, click No. 

3.2.1.4 Output Metonic Tide Statistics  

Selecting this command will prompt the user to enter a name for the CSV file that results from 

this action. The resulting file will contain information on the currently selected tide station as 

follows: Station Name, High Tide Max, High Tide Mean, High Tide Min, Low Tide Max, Low 

Tide Mean, Low Tide Min. After the file is created the user will receive a message stating that 

the file is ready for review. Click OK to continue using the application. Note that this option is 

not available if a current station has been selected. 

3.2.1.5 Output Station Statistics for Period  

Selecting this command will prompt the user to enter a name for the CSV file that results from 

this action. The resulting file will contain the recorded tide heights or currents (based whether a 

tide or current station is selected) for the currently selected station for the timeframe selected. 

The timeframe displayed in the report is based on what is shown on the Station Information tab, 

See Section 3.3.3.1 Station Information 

3.2.1.6 Output Full Station Report for Period  

Selecting this command will prompt the user to enter a name for the Excel file that results from 

this action.  The resulting workbook contains a single worksheet with both Exceedance Function 

and Tide/Current Values.  This worksheet contains tide/current information for the selected 

tide or current station for the timeframe specified on the Station Information tab in the Data 

Pane.  Images are provided for the Exceedance Function and Tide/Current Values chart for the 

selected station.  Note that the data points are only included if the selected time range is less 

than 3 years.  These values can be exported separately to CSV files if the date range exceeds the 
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3 year mark.  This limitation is due to inefficiencies in a 3rd party library which result in 

extremely poor performance leading to critical errors for larger datasets.   

After the file is created, the user will receive a message noting the directory path to the resulting 

file. The user should click OK to continue using the application. 

3.2.3 About 

Selecting the IWR Tide Tool from the About menu provides the user with information about the 

application including the version number, as shown in Figure 45. 

 

Figure 45. About Menu Display 

3.3 Panes 
When the Tide Tool is launched the screen is divided into three windows, the Navigation Pane, 

the Graphics Pane, and the Data Pane, as shown in Figure 46. The Navigation Pane displays an 

expandable tree of information the user can select from related to the tide stations, organized 

first by existing and custom stations and then within existing stations they are organized by 

geographic location. The Graphics Pane will display on the upper right side of the screen and is 

separated into three tabs:  Map, Exceedance Function, and Values. The Data Pane will supply 

information about the currently selected item in the Navigation Pane. 
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Figure 46. Tide Tool Window Panes 

3.3.1 Navigation Pane 

Within this pane is a tree structure consisting of existing reference and secondary tide and 

current stations as well as any custom stations that have been created.  Existing Stations are 

broken down into global regions.  Selecting a region then further breaks the list into countries, 

states, and islands.  Once the desired location has been selected, a list of existing reference and 

secondary tide and current stations will be available.  The “Custom Station” branch is available 

but will not have any custom stations inside until they have been created by the user.  Further 

information on Custom Stations can be found in Section 3.3.3.2 Create Secondary Station and 

Section 4 Creating Custom Stations. 

3.3.1.1 Existing Stations (WTides) 

Under ‘All Tide Stations’ there are two options that are available:  Existing Stations and Custom 

Stations.  Clicking on the plus by Existing Stations produces a drop down menu with a list of 

regions.  Selecting any one of these options will result in either a list of countries, states, or 
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islands to refine the search.  Once a specific country has been selected the user will either have 

the option of picking a tide or current station or selecting a state and picking a tide or current 

station.  The existing tide and current stations represent all the red and blue pins that populated 

the globe when the tool was first launched.  Tide stations are represented with red pins while 

current stations are represented with blue pins.  

When selecting a tide or current station it is important to remember that there are reference 

stations as well as secondary stations.  Reference stations provide full daily tide predictions to a 

relatively small number of locations.  Secondary stations make up the majority of the tide 

stations.  Secondary stations are obtained by applying differences to the times and heights of 

tides for a reference station.  When looking at a list of tide stations, reference stations will 

generally have the letter ‘R’ after the name.  Once a specific station has been selected, whether a 

reference or secondary, the Graphics Pane will zoom into that location.  At that time, the user 

will be presented with station information in the Station Information tab. 

3.3.1.2 Custom Stations 

Custom Stations can also be accessed through the Navigation Pane.  There will only be a custom 

station in the drop down menu if one has been created by the user.  There are no custom 

stations initially available when the Tide Tool is first launched.  Once created, custom stations 

are considered secondary stations.  Custom Stations can be created by clicking on the Create 

Secondary Station tab in the Data Pane.  The creation of Custom Stations will be discussed in 

Section 4. 

3.3.2 Graphics Pane 

The Graphics Pane provides several different functions within the Tide Tool.  Initially the 

Graphics Pane contains the Google Earth map of the globe.  After a tide or current station has 

been chosen, this Pane provides a map of the station location.  During the exploration of the 

station, the Graphics Pane also serves as the window for viewing the Exceedance Function and 

current/tide values. The following viewing options are available within the Graphics Pane:  

Map, Exceedance Function, and Values, as discussed below. 

3.3.2.1 Map 

The Map tab has a Google Earth interface that provides the user with a satellite image of tide 

and current station locations, see Figure 47.  From this screen it is also possible to adjust the 

zoom, grab and move around the globe, and to adjust the view of the globe. When selecting the 

location for a custom station, the latitude/longitude can be added to the Data Pane, Create 

Secondary Station tab, by left-clicking with the mouse in the location where the station data is 

desired. 
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Figure 47. Google Earth Interface in Graphic Pane 

Clicking on the Map tab of the Graphics Pane will produce a couple different 
images depending on the selection that has been made in the Navigation Pane. 
Moving the cursor over to the upper right hand corner of the screen will make 
the Navigation Tool appear and moving away will make it disappear.  The 
Navigation Tool has the following functions: 

Zooming In and Out – The Zoom function is located at the bottom of the 
Navigation Tool.  Clicking the plus and minus buttons will zoom in and out 
accordingly.  The user may also use the slider option for zooming. 

Looking – The Look function is located at the top of the Navigation Tool, it has 
an eye in the center.  To look left, click right.  To look right, click left.  To look 
up, click up and to look down, click down.  To return to the standard compass 
view simply click on N for North. 

Moving – The move function is in the middle of the Navigation Tool, it has a 
hand in the center.  Clicking on the arrows surrounding the hand will allow the user to move 
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about the image.  Holding down the left click and moving the mouse will also allow the user to 
move about the image.    

3.3.2.2 Exceedance Function 

This tab provides a graph of the exceedance function for the current or tide station selected for 

the time frame specified, as shown in Figure 48.  The tide/current value is represented on the x-

axis and the exceedance frequency, or fraction of time that the tide height or current knots is 

greater than the value, is represented on the y-axis. A separate pane on the Exceedance Function 

view provides the data in tabular format.  The first column gives the tide or current value and 

the second column provides the associated exceedance function. Note that current data are 

provided in knots. Tide values are provided in feet and are measured at Mean Lower Low 

Water (MLLW). As an example, the correct interpretation of the highlighted values in the table 

in Figure 48 is: 

The tide value at Charleston Harbor (selected station) from December 9, 2011 through 

January 8, 2012 (the period specified) was greater than -0.782151 (X) feet 99.997 (Y 

converted to percent) percent of the time. 

 
Figure 48. Exceedance Function Tab in Graphics Pane 

3.3.2.3 Values 

The Values tab provides a graph of the tidal cycle or currents for the specified time frame, as 

shown in Figure 49. The date and time are represented on the x-axis. The tidal/current value is 

represented on the y-axis. This is also presented in a tabular format on the adjacent pane. The 

time and date are given in the first column and the associated tidal value is given in the second 

column. Current data are provided in knots while tide values are provided in feet. 
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Figure 49. Values Tab in Graphics Pane 

3.3.2.4 Export Dialog for Graphics 

Right-clicking on either the Exceedance Function or Values graphic will provide menu options 

for changing the design of the graphic and for exporting the graphic to an external file. When 

‘Export Dialog’ is selected, the window prompt shown in Figure 50 appears. The user should 

specify what file type is desired, the file destination, and export size. When these parameters are 

set, select ‘Export’ to create the file.  

 
Figure 50. Export Dialog for Graphics 

3.3.3 Data Pane 

The Data Pane consists of two panes: Station Information and Create Secondary Station.  Station 

Information provides the user with detailed information on the chosen tide or current station.  
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The Create Secondary Station tab allows the user to specify the parameters for the desired 

secondary station and create the station, which is then added to the Navigation Pane. 

3.3.3.1 Station Information 

Once a tide station or current station has been selected or created, detailed information 

regarding the station can be reviewed in the Data Pane under this tab, see Figure 51. The Station 

Information tab provides the following to the user within the box titled “Station Information”: 

 Station name 

 Time Zone 

 Latitude 

 Longitude 

 Current station: (Y/N) 

 Reference station: (Y/N) 

 Reference station name 

 Station notes 

 The harmonic source file 

 

 

Figure 51. Station Information Tab in Data Pane 

Date Selection Mode The user can define the data selection mode using the option in the upper 
right hand of the Data Pane. The Date Selection Mode allows the user to choose how long the 
information for the tides will be calculated. There are four options to choose from: 

 Default – This setting gives today’s date as the start date and the end date as thirty days 
after the start date. 



39 

 Today – This setting gives today’s date as the start date and provides 24 hours worth of 
tide data. 

 Metonic – This setting will calculate the 19-year Metonic cycle. When selected this option 
will present the user with a pop-up window that asks if they wish to proceed. The 
reason for this warning is that it takes a considerable amount of time to calculate the 
Metonic data (approximately 15-20 minutes per station).  

 Custom – This setting allows the user to vary the start and end date. After choosing the 
desired dates, you must click “GO”.  

Additional Station Information  Directly below the Date Selection Mode is the following 
additional station information: 

 Station Name 

 Latitude, Longitude 

 Note: This can be notes on the source of the data 

 Mathematical Upper bound 

 Mathematical Lower bound 

 Mean Sea Level 

 Search Interval 

 Max Tide: height(ft), date, and time of occurrence 

 Min Tide: height(ft), date, and time of occurrence 

3.3.3.2 Create Secondary Station 

When a reference station has been selected in the Navigation Pane, the option will be available 

in the Data Pane to create a secondary station.  In the tab titled Create Secondary Station, the 

user is provided the reference station name and time zone, and the latitude and longitude of the 

location selected for the secondary station.  The user is able set the minimum and maximum 

offset values for the following variables that will be used to create the custom station: Time Add 

Hours; Time Add Minutes; Level Add; and Level Multiply. Latitude and longtitude can be set 

by clicking the lcoation on the map where the station location is desired. 

If a current station is selected as the reference station, then the Level Add units will be specified 

in Knots, as shown in Figure 52. If a tidal station is selected as the reference station, the user 

should indicate whether the Level Add values are in feet or meters by selecting the appropriate 
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radio box, as shown in Figure 53. Once the appropriate paramters have been set, the user 

should select the ‘Create Station’ button. The user will receive a message that the custom station 

has been created. Note: the user must close Tide Tool and re-launch the application in order for 

the newly created secondary station to be available under Custom Stations in the Navigation 

Pane. 

 

Figure 52. Create Secondary Current Station 

 

 

Figure 53. Create Secondary Tidal Stations 
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Section 4 Creating Custom Stations 
To create a custom station, select the reference station that you would like the custom station to 

based. 

Note: When creating custom stations it is important to consult with someone knowledgeable about tide 

for the area.  If the offsets are incorrect, tidal values will not be valid.  A coastal engineer or someone from 

the Port would be excellent resources. 

Once the reference station is selected, click on the “Create Secondary Station” tab.  Position the 

cursor over the location on the map where the custom station is desired and left click.  Notice 

how the Latitude and Longitude points in the data pane change as you click on the map.  

Create a name in the “Subordinate Station Name” box.  For maximum and minimum tides, 

adjustments are made to the elevation and time components of the reference station tide.  Time 

is adjusted by hours and minutes. Elevation is adjusted by adding/subtracting feet and using a 

multiplier.  Once these values are input click create station.  

Tide Tool will need to be closed and then re-launched in order for the custom station to 

appear under Custom Stations in the Navigation Pane. If custom stations are being created to 

be used in HarborSym these will automatically populate when populate stations is selected for 

the project alternative.   

Statistics may now be run for any period of time and output analysis completed.  It is important 

to compare the output obtained from the created secondary station to output from the reference 

station to ensure that the values make sense and there was not an input error.  Custom stations 

can be deleted by right clicking on “Custom Stations” under “All Tide Stations” and selecting 

“Delete All Custom Stations” or by right clicking on a specific custom station and selecting 

“Delete Station.”  


